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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily harm or 
loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage to 
equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product features

This guide describes the features of the thin client. For more information about the hardware and software 
installed on this thin client, go to http://www.hp.com/go/quickspecs and search for this thin client.

Various options are available for your thin client. For more information about some of the available options, 
go to the HP website at http://www.hp.com and search for your specific thin client.

Front panel components
For more information, go to http://www.hp.com/go/quickspecs and search for your specific thin client to find 
the QuickSpecs.

Item Component Item Component

1 Power button 4 USB 3.0 ports (2)

Front panel components 1
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Item Component Item Component

2 Flash drive activity LED 5 Headset port

3 USB 2.0 ports (2) 6 Headphone port
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Rear panel components
For more information, go to http://www.hp.com/go/ quickspecs/ and search for your specific thin client to find 
the QuickSpecs.

Item Component Item Component

1 PS/2 mouse port 9 PS/2 keyboard port

2 Parallel port 10 Dual-mode DisplayPort 1.2 ports (4)

3 Serial ports (2) 11 Ethernet RJ-45 port

4 USB 2.0 ports (4) 12 Audio line-in port

5 Low-profile PCIe expansion slot* 13 Audio line-out port

6 Fiber NIC slot* 14 Power

7 Retractable AC power cord retention hook 15 Rear I/O panel latch

8 Cable lock slot   

*Optional

Rear panel components 3
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Serial number location
Every thin client includes a unique serial number located as shown in the following illustration. Have this 
number available when contacting HP customer service for assistance.
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2 Hardware changes

Warnings and cautions
Before performing upgrades be sure to carefully read all of the applicable instructions, cautions, and 
warnings in this guide.

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot surfaces, or 
fire:

Disconnect the AC power cord from the AC outlet and allow the internal system components to cool before 
you touch them.

Do not plug telecommunications or telephone connectors into the network interface controller (NIC) 
receptacles.

Do not disable the AC power cord grounding plug. The grounding plug is an important safety feature.

Plug the AC power cord into a grounded (earthed) AC outlet that is easily accessible at all times.

To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper workstation setup, 
posture, and health and work habits for computer users, and provides important electrical and mechanical 
safety information. The Safety & Comfort Guide is located on the HP website at http://www.hp.com/ergo.

WARNING! Energized parts inside.

Disconnect power to the equipment before removing the enclosure.

Replace and secure the enclosure before re-energizing the equipment.

CAUTION: Static electricity can damage the electrical components of the thin client or optional equipment. 
Before beginning the following procedures, be sure that you are discharged of static electricity by briefly 
touching a grounded metal object.

When the thin client is plugged into an AC power source, voltage is always applied to the system board. To 
prevent damage to internal components, you must disconnect the AC power cord from the power source 
before opening the thin client.

Removing and replacing the access panel

Removing the access panel

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot surfaces, or 
fire, ALWAYS operate the thin client with the access panel in place. In addition to enhancing safety, the access 
panel may provide important instructions and identification information, which may be lost if the access 
panel is not used. DO NOT use any access panel except the one that is provided by HP for use with this thin 
client.

Before removing the access panel, be sure that the thin client is turned off and the AC power cord is 
disconnected from the AC outlet.

To remove the access panel:

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.
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3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. You must disconnect the AC power cord to avoid damage 
to the internal components of the thin client.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Release the latch (1) on the left side of the rear I/O panel, rotate the I/O panel (2) to the right, and then 
lift it off the thin client.

8. Move the access panel latch (1) down to release the access panel.

9. Slide the access panel approximately 6 mm (.24 in) toward the back of the chassis, and then lift the 
panel off of the thin client (2).
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Replacing the access panel

To replace the access panel:

1. Position the access panel on the chassis, approximately 6 mm (.24 in) inside the edge of the chassis. 
Slide the panel toward the front of the chassis (1) until it locks into place.

2. Move the access panel latch (2) up to secure the access panel.

3. Insert the hooks on the right side of the rear I/O panel (1) into the right side of the back of the chassis, 
rotate the left side (2) to the chassis, and then press it to the chassis until it locks in place.

Removing and replacing the access panel 7



Locating internal components

Item Component Item Component

1 Memory compartment 4 PCIe riser connector

2 M.2 socket with flash storage module installed 5 M.2 socket with Wi-Fi module installed

3 USB 3.0 port 6 Battery
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Removing and replacing the M.2 flash storage module
To remove the M.2 flash storage module:

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.

3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. You must disconnect the AC power cord to avoid damage 
to the internal components of the thin client.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Remove the thin client access panel. See Removing and replacing the access panel on page 5.

8. Locate the M.2 socket for flash storage module on the system board. See Locating internal components 
on page 8.

9. Loosen the screw securing the flash storage module until the end of the module can be raised.

10. Pull the flash storage module out of the socket.
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11. Pull the screw kit off of the flash storage module and attach it to the replacement flash storage module.

12. Slide the new flash storage module into the M.2 socket on the system board and press the module 
connectors firmly into the socket.

NOTE: A flash storage module can be installed in only one way.
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13. Press the flash storage module down and use a screwdriver to tighten the screw and secure the module 
to the system board.

14. Replace and latch the access panel, and then reinstall the rear I/O panel. See Removing and replacing 
the access panel on page 5.

15. Replace the thin client stand.

16. Reconnect the AC power cord and turn on the thin client.

17. Lock any security devices that were disengaged when the thin client access panel was removed.

Removing and replacing the battery
WARNING! Before removing the access panel, be sure that the thin client is turned off and the AC power cord 
is disconnected from the AC outlet.

To remove and replace the battery:

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.

3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. You must disconnect the AC power cord to avoid damage 
to the internal components of the thin client.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Remove the thin client access panel. See Removing and replacing the access panel on page 5.

8. Locate the battery on the system board. See Locating internal components on page 8.

9. To release the battery from its holder, squeeze the metal clamp that extends above one edge of the 
battery. When the battery pops up, lift it out (1).
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10. To insert the new battery, slide one edge of the replacement battery under the holder’s lip with the 
positive side up. Push the other edge down until the clamp snaps over the other edge of the battery (2).

11. Replace and latch the access panel, and then reinstall the rear I/O panel. See Removing and replacing 
the access panel on page 5.

12. Replace the thin client stand.

13. Reconnect the AC power cord and turn on the thin client.

14. Lock any security devices that were disengaged when the thin client access panel was removed.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable 
batteries. For more information about recycling programs, go to http://www.hp.com and search for “recycle”.

 

Batteries, battery packs, and accumulators should not be disposed of together with the general household 
waste. In order to forward them to recycling or proper disposal, please use the public collection system or 
return them to HP, an authorized HP partner, or their agents.

 

The Taiwan EPA requires dry battery manufacturing or importing firms, in accordance with Article 15 or the 
Waste Disposal Act, to indicate the recovery marks on the batteries used in sales, giveaways, or promotions. 
Contact a qualified Taiwanese recycler for proper battery disposal.
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Replacing a low-profile PCI-Express card
An optional low-profile PCI-Express (PCIe) graphics card may be installed in the thin client. A riser card is 
installed in this thin client by default.

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot surfaces, or 
fire, disconnect the AC power cord from the AC outlet and allow the internal system components to cool 
before you touch them.

To install a PCIe card:

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.

3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. You must disconnect the AC power cord to avoid damage 
to the internal components of the thin client.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Remove the thin client access panel. See Removing and replacing the access panel on page 5.

8. Locate the PCIe card on the system board. See Locating internal components on page 8.

9. Press the latch down and move it to the left (1) to release the PCIe card.

10. Carefully pull the PCIe card out of the socket (2). You may need to pull one side and then the other to 
remove the card.

11. If you are installing a PCIe card that requires an opening in the chassis, push the expansion slot cover out 
of the rear I/O panel.

12. Align the PCIe card connectors with the slot in the riser card and the metal tab at the end of the card with 
the slot in the chassis. Press the PCIe card firmly into the slot in the riser card (1) until it is securely 
seated and the tab is in the slot.
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13. Press the latch down and move it to the right until it clicks into place (2) to secure the PCIe card.

14. Replace and latch the access panel, and then reinstall the rear I/O panel. See Removing and replacing 
the access panel on page 5.

15. Replace the thin client stand.

16. Reconnect the AC power cord and turn on the thin client.

17. Lock any security devices that were disengaged when the thin client access panel was removed.
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Replacing a WLAN module
An optional WLAN module may be installed in the thin client.

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot surfaces, or 
fire, disconnect the AC power cord from the AC outlet and allow the internal system components to cool 
before you touch them.

To replace a WLAN module:

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.

3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as 
the system is plugged into an active AC outlet. You must disconnect the AC power cord to avoid damage 
to the internal components of the thin client.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Remove the thin client access panel. See Removing and replacing the access panel on page 5.

8. Locate the WLAN module on the system board. See Locating internal components on page 8.

9. Disconnect the WLAN antenna cables (1) from the terminal on the WLAN module.

NOTE: The number of antenna cables may vary.

10. Remove the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board. (The 
WLAN module tilts up.)
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11. Remove the WLAN module by pulling the module away from the slot at an angle (3).

12. Insert the WLAN module into the slot (1).

13. Insert the Phillips PM2.0×3.0 screw (2) that secures the WLAN module to the system board.

14. Connect the WLAN antenna cables (3) to the terminals on the WLAN module.

NOTE: The number of antenna cables may vary.

NOTE: The #1 WLAN antenna cable is connected to the WLAN module Main terminal.

If two antennas are connected, the #2 WLAN antenna cable is connected to the WLAN module Aux 
terminal.
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15. Replace and latch the access panel, and then reinstall the rear I/O panel. See Removing and replacing 
the access panel on page 5.

16. Replace the thin client stand.

17. Reconnect the AC power cord and turn on the thin client.

18. Lock any security devices that were disengaged when the thin client access panel was removed.

Installing an internal USB flash drive
There is one USB 3.0 flash drive port on the system board.

To install a USB flash drive:

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.

3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Remove the thin client access panel. See Removing and replacing the access panel on page 5.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system components 
to cool before you touch them.

8. Locate the USB flash drive port on the system board. See Locating internal components on page 8.

9. Align the USB flash drive with the USB port and press the drive firmly into the port until it is securely 
seated.

10. Replace and latch the access panel, and then reinstall the rear I/O panel. See Removing and replacing 
the access panel on page 5.

11. Replace the thin client stand.
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12. Reconnect the AC power cord and turn on the thin client.

13. Lock any security devices that were disengaged when the thin client access panel was removed.

Installing additional SDRAM system memory
The thin client comes with dual channel, double data rate 3 synchronous dynamic random access memory 
(DDR3/DDR3L) small outline dual inline memory modules (SODIMMs).

SODIMMs

The memory sockets on the system board can be populated with up to two industry-standard SODIMMs. 
These memory sockets are populated with at least one preinstalled SODIMM. To achieve the maximum 
memory support, you can populate the system board with up to 16 GB of memory.

DDR3L-SDRAM SODIMMs

For proper system operation, the SODIMMs must adhere to the following specifications:

● industry-standard 204-pin

● unbuffered non-ECC PC3L-12800 DDR3L-1600 MHz-compliant

● 1.35 volt DDR3L-SDRAM SODIMMs

● support CAS latency 11 DDR3L 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

The thin client supports the following:

● 2 Gb and 4 Gb non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not supported

NOTE: The system does not operate properly when unsupported SODIMMs are installed.

Populating SODIMM sockets

There are two SODIMM sockets on the system board. The sockets are labeled DIMM1 and DIMM2.

Item Description System Board Label

1 SODIMM1 socket DIMM1

2 SODIMM2 socket DIMM2

The system operates in dual-channel mode.
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Installing SODIMMs

CAUTION: You must disconnect the AC power cord and wait approximately 30 seconds for the power to drain 
before adding or removing memory modules. Regardless of the power-on state, voltage is always supplied to 
the memory modules as long as the thin client is plugged into an active AC outlet. Adding or removing 
memory modules while voltage is present may cause irreparable damage to the memory modules or system 
board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is important 
to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation resulting from 
having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the thin client or optional cards. Before beginning 
the following procedures, be sure that you are discharged of static electricity by briefly touching a grounded 
metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage the 
module.

1. Remove/disengage any security devices that prohibit opening the thin client.

2. Remove all removable media, such as USB flash drives, from the thin client.

3. Turn off the thin client properly through the operating system, and then turn off any external devices.

4. Disconnect the AC power cord from the AC outlet, and disconnect any external devices.

CAUTION: You must disconnect the AC power cord and wait approximately 30 seconds for the power to 
drain before adding or removing memory modules. Regardless of the power-on state, voltage is always 
supplied to the memory modules as long as the thin client is plugged into an active AC outlet. Adding or 
removing memory modules while voltage is present may cause irreparable damage to the memory 
modules or system board.

5. Remove the stand from the thin client.

6. Lay the unit flat on a stable surface with the right side up.

7. Remove the thin client access panel. See Removing and replacing the access panel on page 5.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system components 
to cool before you touch them.

8. Locate the memory compartment on the system board. See Locating internal components on page 8.

9. If a PCIe card is installed, remove it.

10. Loosen the two captive screws (1) securing the memory compartment cover.
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11. Lift the memory compartment cover out of the chassis (2).

12. To remove a SODIMM, press outward on the two latches on each side of the SODIMM (1), rotate the 
SODIMM up, and then pull the SODIMM out of the socket (2).
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13. Slide the new SODIMM (1) into the socket at approximately a 30° angle, and then press the SODIMM 
down (2) so that the latches lock it in place.

NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab 
on the memory socket.

14. Align the memory compartment cover with the two posts and the clips at the base of the compartment, 
and then set the memory compartment cover (1) over the SODIMMs.

TIP: The small clips are pairs. When the compartment is properly placed, one of each pair will be inside 
the compartment and one will be outside.

15. Tighten the two captive screws (2) to secure the memory compartment cover.

16. Replace and latch the access panel, and then reinstall the rear I/O panel. See Removing and replacing 
the access panel on page 5.

17. Replace the thin client stand.

18. Reconnect the AC power cord and turn on the thin client.

19. Lock any security devices that were disengaged when the thin client access panel was removed.

The thin client automatically recognizes the additional memory when you turn on the thin client.
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A Computer Setup (F10) Utility, BIOS Settings

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics, 
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as solid-state drives or USB flash media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test (POST) 
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product 
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the 
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1 
through F12).

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings 
described in this section.

● Secure integrated I/O functionality, including the USB, audio, or embedded NIC, so that they cannot be 
used until they are unsecured.

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the 
Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Press either esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at the 
bottom of the screen.

Pressing esc displays a menu that allows you to access different options available at startup.

NOTE: If you do not press esc or F10 at the appropriate time, you must restart the computer and again 
press esc or F10 when the monitor light turns green to access the utility.

NOTE: You can select the language for most menus, settings, and messages using the Language 
Selection option using the F8 key in Computer Setup.

3. If you pressed esc, press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security, Power, 
and Advanced.
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5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys 
to select the option you want, then press enter. To return to the Computer Setup Utilities menu, press 
esc.

6. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and Exit.

● To reset to factory settings, select Apply Defaults and Exit. This option will restore the original 
factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes 
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup 
screen.

Heading Table

File Computer Setup—File on page 24

Storage Computer Setup—Storage on page 25

Security Computer Setup—Security on page 26

Power Computer Setup—Power on page 28

Advanced Computer Setup—Advanced on page 28
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Option Description

System Information Lists:

● Product name

● SKU number

● System Board CT Number

● Processor type

● Processor speed

● Processor stepping

● Cache size (L1/L2)

● Memory size

● Integrated MAC

● System BIOS

● Chassis serial number

● Asset tracking number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System BIOS Allows you to flash system BIOS from a USB recovery key.

Default Setup Allows you to:

● Save Current Settings as Default

● Restore Factory Settings as Default

Apply Defaults and Exit Loads the original factory system configuration settings for use by a subsequent “Apply Defaults and 
Exit” action.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

Option Description

Device Configuration Lists all installed BIOS-controlled storage devices. When a device is selected, detailed information and 
options are displayed. The following options may be presented:

Hard Disk: Size, model, firmware version, serial number.

Storage Options SATA Emulation

CAUTION: SATA emulation changes may prevent access to existing drive data and degrade or corrupt 
established volumes.

Allows you to choose how the SATA controller and devices are accessed by the operating system. There 
are two supported options: IDE and AHCI (default).

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually do 
not require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take advantage of 
more advanced features of the SATA controller.

USB Storage Boot

Allows you to set USB storage device default boot option in CSM/Legacy mode.

DPS Self-test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection System 
(DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS self tests is 
attached to the system.

Boot Order Allows you to:

● Specify the order in which EFI boot sources (such as a internal drive, USB hard drive, or USB optical 
drive) are checked for a bootable operating system image. Each device on the list may be individually 
excluded from or included for consideration as a bootable operating system source. EFI boot sources 
always have precedence over legacy boot sources.

● Specify the order in which legacy boot sources (such as a network interface card, internal drive, or 
USB optical drive) are checked for a bootable operating system image. Each device on the list may be 
individually excluded from or included for consideration as a bootable operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in the 
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.

MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer 
and press esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu) 
when the monitor light turns green. After POST is completed, a list of bootable devices is displayed. Use 
the arrow keys to select the preferred bootable device and press enter. The computer then boots from the 
selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table A-1  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the ROM, and 
make changes to certain plug and play settings under Windows.

Power-On Password Allows you to set and enable a power-on password. The power-on password prompt appears after a 
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Password Options

(This selection appears 
only if a power-on 
password or setup 
password is set.)

Allows you to enable/disable:

● Stringent Password – When set, enables a mode in which there is no physical bypass of the 
password function. If enabled, removing the password jumper will be ignored.

● Password Prompt on F9 & F12 – Default is enabled.

● Setup Browse Mode – Allows viewing, but not changing, the F10 Setup Options without entering 
setup password). Default is enabled.

Device Security Allows you to set Device Available/Device Hidden (default is ‘Device Available’) for:

● Embedded Security Device

● System audio

● Network controller

● SATA Port 0

USB Security Allows you to set Enabled/Disabled (default is enabled) for:

● Front USB Ports

— USB Port 4

— USB Port 5

— USB Port 10

— USB Port 11

● Rear USB Ports

— USB Port 0

— USB Port 1

— USB Port 2

— USB Port 3

● Accessory USB Ports

— USB Port 12

Slot Security Allows you to disable the PCI Express slot and Mini Card Slot. Default is enabled.

● PCI Express x8 Slot 1

● M.2 PCIe x1

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network server. 
(Feature available on NIC models only; the network controller must be either a PCI expansion card or 
embedded on the system board.) Default is enabled.
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Table A-1  Computer Setup—Security (continued)

Option Description

System IDs Allows you to set:

● Asset tag (18-byte identifier) – A property identification number assigned by the company to the 
computer.

● Ownership tag (80-byte identifier)

Tool-less BIOS Update Allows you to enable the tool-less BIOS feature, in which BIOS invokes HpBiosUpdate.efi (HpBiosMgmt.efi) 
and related toolsets in internal/external storage during the last stage of POST.

● BIOS Update (enable/disable)

● BIOS Image File Name

System Security Provides these options:

● Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches. 
Default is enabled.

● Virtualization Technology (enable/disable) – Controls the virtualization features of the processor. 
Changing this setting requires turning the computer off and then back on. Default is disabled.

● Embedded Security Device (enable/disable) – Permits activation and deactivation of the Embedded 
Security Device. Changing this setting requires turning the computer off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

○ Reset to Factory Setting (Do not reset/Reset) – Resetting to factory defaults will erase all 
security keys. Changing this setting requires turning the computer off and then back on. 
Default is ‘Do not reset’.

○ Measure boot variables/devices to PCR1 (disable/enable) – Typically, the computer measures 
the boot path and saves collected metrics to PCR5 (a register in the Embedded Security 
Device). Bitlocker tracks changes to any of these metrics, and forces the user to re-
authenticate if it detects any changes. Enabling this feature lets you set Bitlocker to ignore 
detected changes to boot path metrics, thereby avoiding reauthentication issues associated 
with USB keys inserted in a port. Default is enabled.

● OS Management of Embedded Security Device (enable/disable) – This option allows the user to limit 
operating system control of the Embedded Security Device. Changing this setting requires turning 
the computer off and then back on. This

● Reset of Embedded Security Device through OS (enable/disable) – This option allows the user to limit 
the operating system ability to request a Reset to Factory Settings of the Embedded Security Device. 
Changing this setting requires turning the computer off and then back on. Default is disable.

NOTE: To enable this option, a Setup password must be set.

● No PPI provisioning (enable/disable) – This option lets you set the operating system to bypass the 
PPI (Physical Presence Interface) requirement and directly enable and take ownership of the TPM on 
first boot. You cannot change this setting after TPM is owned/initialized, unless the TPM is reset.

● Allow PPI policy to be changed by OS (enable/disable) – Enabling this option allows the operating 
system to execute TPM operations without Physical Presence Interface. Default is disabled.

Secure Boot 
Configuration

The options on this setup page are only for Windows 10 and other operating systems that support Secure 
Boot. Changing the default setting of the setup options on this page for operating system that do not 
support secure boot may prevent the system from booting successfully.

Legacy Support (enable/disable) – Enable or disable the legacy operating system support (Windows 
Embedded Standard 7 and HP Thin-Pro).

Secure Boot (enable/disable) – Only when the Legacy Support set to disable, this item can be set to 
enable. This item is for Secure Boot flow control. Secure boot is possible only if system run in user mode.

Key Management

● Clear Secure Boot Keys (Clear/Don’t Clear). Lets you clear the Secure Boot Key.
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Table A-1  Computer Setup—Security (continued)

Option Description

● Key ownership (HP keys/Customer keys). Lets you change the keys of different owners.

Fast Boot (Enable/Disable) – Enable Fast Boot cause system boot by initializing a minimal set of devices 
which is required to launch active boot option. This option has no effect for BBS boot options.

Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table A-2  Computer Setup—Power

Option Description

OS Power Management Runtime Power Management (enable/disable) – Allows certain operating systems to reduce processor 
voltage and frequency when the current software load does not require the full capabilities of the 
processor. Default is enabled.

Idle Power Savings (Extended/Normal) – Extended/Normal. Allows certain operating systems to decrease 
the processors power consumption when the processor is idle. Default is ‘extended’.

ACPI S3 PS2 Mouse Wake Up (enable/disable) – Enables or disables waking from S3 due to any PS2 mouse 
activity or a button click only.

Hardware Power 
Management

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to meet 
EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

Thermal Fan Idle Mode – Allows you to set default fan speed in idle mode.

CPU Fan speed (Read-Only) – shows the CPU fan speed in RPM.

Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table A-3  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST messages (enable/disable) – Default is disabled.

● Press the ESC key for Startup Menu (Displayed/Hidden).

● After Power Loss (off/on/previous state) – Default is Power off. Set this option as follows:

— Power off—causes the computer to remain powered off when power is restored.

— Power on—causes the computer to power on automatically as soon as power is restored.

— Previous state—causes the computer to power on automatically as soon as power is restored, 
if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be able to 
use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds) – Enabling this feature will add a user-specified delay to the POST process. 
This delay is sometimes needed for hard disks on some PCI cards that spin up very slowly, so slowly 
that they are not ready to boot by the time POST is finished. The POST delay also gives you more 
time to select F10 to enter Computer (F10) Setup. Default is ‘None’.
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Table A-3  Computer Setup—Advanced (for advanced users) (continued)

Option Heading

● Bypass F1 Prompt on Configuration Changes (enable/disable).

● Remote Wakeup Boot Source (Local Hard Drive/Remote Server). Allows you to set the source from 
which the computer gets its boot files when remotely awakened.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable legacy devices.

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration space; only 
needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Integrated Graphics (Auto/Force) – Use this option to manage integrated (UMA) graphics memory 
allocation. The value you choose allocates memory permanently to graphics and is unavailable to 
the operating system. For example, if you set this value to 512M on a system with 2 GB of RAM, the 
system always allocates 512 MB for graphics and the other 1.5 GB for use by the BIOS and operating 
system. Default is Auto which sets memory allocation to 512 MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA memory 
size allocation between 256 MB and 1 GB.

● USB Port Configuration (Auto/Force 2.0)

● S5 Wake on LAN (enable/disable)

● Printer mode (Bi-Directional, EPP + ECP, Output Only). Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Multi-Processor (enable/disable) – Use this option to disable multiprocessor support under the 
operating system. Default is enable.

● Internal Speaker (some models) (does not affect external speakers) – Default is enabled.

Option ROM Launch 
Policy

Allows you to set:

● Onboard NIC PXE Option ROMs (enable/disable)

● M.2 Slot Option ROM Download (enable/disable)

● PCIE Slot Option ROM Download (enable/disable)
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Changing BIOS Settings from the HP BIOS Configure Utility 
(HPBCU)

Some BIOS settings may be changed locally within the operating system without having to go through the 
F10 utility. This table identifies the items that can be controlled with this method.

BIOS setting Default value Other values

Language English Francais, Espanol, Deutsch, Italiano, Dansk, Suomi, Nederlands, Norsk, 
Portugues, Svenska, Japanese

Set Time 00:00 00:00:23:59

Set Day 01/01/2011 01/01/2011 to current date

Default Setup None Save Current Settings as Default; Restore Factory Settings as Default

Apply Defaults and Exit Disable Enable

SATA Emulation AHCI IDE

USB Storage Boot Before SATA After SATA

UEFI Boot Sources Windows Boot Manager USB Floppy/CD; USB hard drive

Legacy Boot Sources USB floppy/CD Hard drive

Embedded Security 
Device(Device Security)

Device available Device hidden

System Audio Device available Device hidden

Network Controller Device available Device hidden

SATA0 Device available Device hidden

Front USB Ports Enable Disable

USB Port 4, 5, 10 & 11 Enable Disable

Rear USB Ports Enable Disable

USB Port 0, 1, 2 & 3 Enable Disable

Internal USB Ports Enable Disable

USB Port 12 Enable Disable

PCI Express x8 Slot 1 Enable Disable

M.2 PCIe x Enable Disable

Network Boot Enable Disable

Asset Tracking Number   

Ownership Tag   

BIOS Update Disable Auto; Force

BIOS Image File Name   

Data Execution Prevention Enable Disable

Virtualization Technology Disable Enable
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BIOS setting Default value Other values

Embedded Security 
Device(System Security)

Disable Enable

Reset to Factory Setting Do not reset Reset

Measure boot variables/
devices to PCR1

Disable Enable

OS management of 
Embedded Security Device

Disable Enable

Reset of Embedded Security 
Device through OS

Disable Enable

No PPI provisioning Disable Enable

Allow PPI policy to be 
changed by OS

Disable Enable

Legacy Support Enable Disable (Note: The default value may be varied depends on the OS)

Secure Boot Disable Enable (Note: The default value may be varied depends on the OS)

Clear Secure Boot Keys Don’t Clear Clear

Key Ownership HP Keys Custom Keys

Fast Boot Disable Enable (Note: The default value may be varied depends on the OS)

Setup Browse Mode Enable Disable

Password Prompt on F9 & 
F12

Enable Disable

Runtime Power Management Enable Disable

Idle Power Savings Extended Normal

ACPI S3 PS2 Mouse Wake Up Enable Disable

S5 Maximum Power Savings Disable Enable

S5 Wake on LAN Disable Enable

CPU Fan Check Enable Disable

POST Messages Disable Enable

Press the ESC key for Startup 
Menu

Displayed Hidden

After Power Loss Off On, Previous State

POST Delay (in seconds) None 5, 10, 15, 20, 60

Bypass F1 Prompt on 
Configuration Changes

Disable Enable

Remote Wakeup Boot Source Local Hard Drive Remote Server

Power on Sunday – Saturday Disable Enable

Power on Time (hh:mm) 00:00 00:00:23:59

Serial Port A IO=3F8; IRQ=4 Disable, IO=3F8h; IRQ=3, IO=2F8h; IRQ=4, IO=2F8h; IRQ=3

Serial Port B IO=2F8h; IRQ=3 Disable, IO=3F8h; IRQ=4, IO=3F8h; IRQ=3, IO=2F8h; IRQ=4
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BIOS setting Default value Other values

Parallel Port IO=378h; IRQ=7; DMA=3 Disable, IO=378h; IRQ=7; DMA=1, IO=278h; IRQ=7; DMA=1, IO=278h; 
IRQ=7; DMA=3, IO=3BCh; IRQ=7; DMA=1, IO=3BCh; IRQ=7; DMA=3

PCI SERR# Generation Enable Disable

PCI VGA Palette Snooping Disable Enable

Integrated Graphics Auto Disable, Force

UMA Frame Buffer Size 512M 256M, 1G

USB Port Configuration Auto Force 2.0

Printer Mode EPP+ECP Bi-Directional, Output-Only

Num Lock State at Power- On On Off

Multi-Processor Enable Disable

Internal Speaker Enable Disable

Onboard NIC Option ROM 
Download

PXE Disable

M.2 Solt Option ROM 
Download

Enable Do Not Launch

PCIE Solt Option ROM 
Download

Enable Do Not Launch

Updating or restoring a BIOS
HP Device Manager

HP Device Manager can be used to update the BIOS of a thin client. Customers can use a pre-built BIOS add-on 
or can use the standard BIOS upgrade package along with an HP Device Manager File and Registry template. 
For more information on HP Device Manager File and Registry templates, review the HP Device Manager User 
Guide found at www.hp.com/go/hpdm.

Windows BIOS Flashing

You can use the BIOS Flash Update SoftPaq to restore or upgrade the system BIOS. Several methods for 
changing the BIOS firmware stored on your computer are available.

The BIOS executable is a utility designed to flash the System BIOS within a Microsoft Windows environment. 
To display the available options for this utility, launch the executable file under the Microsoft Windows 
environment.

You can run the BIOS executable with or without the USB storage device. If the system does not have a USB 
storage device installed, the BIOS update will perform under the Microsoft Windows environment and 
followed by system reboot.

Linux BIOS Flashing for ThinPro/Smart Zero 6.x

All BIOS flashing under ThinPro 6.x and later utilizes tool-less BIOS updates, in which the BIOS updates itself.

32 Appendix A   Computer Setup (F10) Utility, BIOS Settings



Use the following comments to flash a Linux BIOS:

● hptc-bios-flash ImageName

Prepares the system to update the BIOS during the next restart. This command automatically copies the 
files into the correct location and prompts you to restart the thin client. This command requires that the 
tool-less update option in the BIOS settings is set to Auto. You can use hpt-bios-cfg to set the tool-
less update option in the BIOS.

● hptc-bios-flash –h
Displays a list of options.

Linux BIOS Flashing for ThinPro/Smart Zero 5.2.1

BIOS flashing under ThinPro/Smart Zero 5.2.1 is similar to that in ThinPro/Smart Zero 6.x and later but the 
ThinPro OS performs the actual update. Use the following command to flash the BIOS (from a command shell 
in administrator mode):

● hptc-bios-flash ImageName

Where ImageName is the path to the BIOS binary file.

BitLocker Drive Encryption / BIOS Measurements

If you have Windows BitLocker Drive Encryption (BDE) enabled on your system, we recommend that you 
temporarily suspend BDE before updating the BIOS. You should also obtain your BDE recovery password or 
recovery PIN before suspending BDE. After the you flash the BIOS, you can resume BDE.

To make a change to BDE, select Start > Control Panel > BitLocker Drive Encryption, click Suspend 
Protection or Resume Protection and then click Yes.

As a general rule, updating the BIOS will modify measurement values stored in the Platform Configuration 
Registers (PCRs) of the system's security module. Temporarily disable technologies that use these PCR values 
to ascertain platform health (BDE is one such example) prior to flashing the BIOS. Once you update the BIOS, 
re-enable the functions and restart the system so that you can take new measurements.

BootBlock Emergency Recovery Mode

In the event of a failed BIOS update (for example if power is lost while updating), the System BIOS may 
become corrupted. BootBlock Emergency Recovery Mode detects this condition and automatically searches 
the root directory of the hard drive and any USB media sources for a compatible binary image. Copy the binary 
(.bin) file in the DOS Flash folder to the root of the desired storage device, and then power on the system. 
Once the recovery process locates the binary image, it attempts the recovery process. The automatic recovery 
continues until it successfully restores or updates the BIOS. If the system has a BIOS Setup password, you may 
need to use the Startup Menu / Utilities submenu to flash the BIOS manually after providing the password. 
Sometimes there are restrictions on which BIOS versions are allowed to be installed on a platform. If the BIOS 
that was on the system had restrictions, then only allowable BIOS versions may be used for recovery.
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B Diagnostics and troubleshooting

LEDs

Table B-1  Power and IDE Flash Activity LEDs

LED Status

Power LED Off When the unit is plugged into the wall socket and the Power LED is off, the unit is powered off. 
However, the network can trigger a Wake On LAN event in order to perform management functions.

Power LED On Displays during boot sequence and while the unit is on. During boot sequence, hardware initialization is 
processed and startup tests are performed on the following:

● Processor initialization

● Memory detection and initialization

● Video detection and initialization

NOTE: If one of the tests fails, the unit will simply stop, but the LED will stay on. If the video test fails, 
the unit beeps. There are no messages sent to video for any of these failed tests.

NOTE: After the video is initialized, anything that fails will have an error message.

NOTE: RJ-45 LEDs are located inside the RJ-45 connector on the top, rear panel of the thin client. The LEDs are visible when the 
connector is installed. Blinking green indicates network activity, and amber indicates a 100MB speed connection.

IDE LED is Off When the unit is powered on and the flash activity light is off, then there is no access to the system 
flash.

IDE LED blinks white Indicates the system is accessing the internal IDE flash.
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Wake-on LAN
Wake-on LAN (WOL) allows a computer to be turned on or resumed from sleep or hibernation state by a 
network message. You can enable or disable WOL in Computer Setup using the S5 Maximum Power Savings 
setting.

To enable or disable WOL:

1. Turn on or restart the computer.

2. Press either esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at the 
bottom of the screen.

NOTE: If you do not press esc or F10 at the appropriate time, you must restart the computer and again 
press esc or F10 when the monitor light turns green to access the utility.

3. If you pressed esc, press F10 to enter Computer Setup.

4. Navigate to Power > Hardware Power Management.

5. Set S5 Maximum Power Savings as follows:

● Disable WOL = Enabled

● Enable WOL = Disabled

6. Press F10 to accept any changes.

7. Select File > Save Changes and Exit.

Power-On Sequence
At power-on, the flash boot block code initializes the hardware to a known state, then performs basic power-
on diagnostic tests to determine the integrity of the hardware. Initialization performs the following functions:

1. Initializes CPU and memory controller.

2. Initializes and configures all PCI devices.

3. Initializes video software.

4. Initializes the video to a known state.

5. Initializes USB devices to a known state.

6. Performs power-on diagnostics. For more information, see “Power-On Diagnostic Tests”.

7. The unit boots the operating system.
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Resetting the Setup and Power-on passwords
You can reset the Setup and Power-on passwords as follows:

1. Turn off the computer and disconnect the power cord from the power outlet.

2. Remove the side access panel and the metal side cover.

3. Remove the password jumper from the system board header labeled PSWD/E49.

4. Replace the metal side cover and the side access panel.

5. Connect the computer to AC power, and then turn on the computer.

6. Turn off the computer and disconnect the power cord from the power outlet.

7. Remove the side access panel and the metal side cover.

8. Replace the password jumper.

9. Replace the metal side cover and the side access panel.

Power-on diagnostic tests
The Power-on diagnostics performs basic integrity tests of the hardware to determine its functionality and 
configuration. If a diagnostic test fails during hardware initialization the unit simply stops. There are no 
messages sent to video.

NOTE: You may try to restart the unit and run through the diagnostic tests a second time to confirm the first 
shutdown.

The following table lists the tests that are performed on the unit.

Table B-2  Power-on diagnostic test

Test Description

Boot Block Checksum Tests boot block code for proper checksum value

DRAM Simple write/read pattern test of the first 640k of memory

Parallel Port Initiates the port’s driver and determines if the device is present

Serial Port Tests the serial port using simple port verification test to determine if ports are present

Timer Tests timer interrupt by using polling method

RTC CMOS battery Tests integrity of RTC CMOS battery

NAND flash device Tests for proper NAND flash device ID present
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Interpreting POST diagnostic front panel LEDs and audible codes
This section covers the front panel LED codes as well as the audible codes that may occur before or during 
POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system 
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect 
the power cord from the wall outlet and allow the internal system components to cool before touching.

NOTE: Recommended actions in the following table are listed in the order in which they should be 
performed.

Not all diagnostic lights and audible codes are available on all models.

Table B-3  Diagnostic front panel LEDs and audible codes

Activity Beeps Possible Cause Recommended Action

White Power LED On. None Computer on. None

White Power LED flashes every 
two seconds.

None Computer in Suspend to 
RAM mode (some models 
only) or normal Suspend 
mode.

None required. Press any key or move the mouse to 
wake the computer.

Red Power LED flashes two 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

2 Processor thermal 
protection activated:

A fan may be blocked or not 
turning.

OR

The heat sink/fan assembly 
is not properly attached to 
the processor.

OR

The unit has vents blocked 
or is in a location where the 
ambient temperature is too 
high.

1. Ensure that the computer air vents are not 
blocked and the processor cooling fan is 
plugged in and running, if equipped.

2. Contact an authorized reseller or service 
provider.

Red Power LED flashes four 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

4 Power failure (power supply 
is overloaded).

OR

The incorrect external 
power supply adapter is 
being used on the unit.

1. Check if a device is causing the problem by 
removing ALL attached devices. Power on the 
system. If the system enters the POST, then 
power off and replace one device at a time and 
repeat this procedure until failure occurs. 
Replace the device that is causing the failure. 
Continue adding devices one at a time to 
ensure all devices are functioning properly.

2. Replace the power supply.

3. Replace the system board.

Red Power LED flashes five 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the memory 
modules or the system board, you must unplug the 
computer power cord before attempting to reseat, 
install, or remove a memory module.

1. Reseat memory modules.

2. Replace memory modules one at a time to 
isolate the faulty module.
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Table B-3  Diagnostic front panel LEDs and audible codes (continued)

Activity Beeps Possible Cause Recommended Action

3. Replace third-party memory with HP memory.

4. Replace the system board.

Red Power LED flashes six times, 
once every second, followed by a 
two second pause. Beeps stop 
after fifth iteration but LEDs 
continue until problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the 
system board.

Red Power LED flashes eight 
times, once every second, 
followed by a two second pause. 
Beeps stop after fifth iteration 
but LEDs continue until problem 
is solved.

8 Invalid ROM based on bad 
checksum.

1. Reflash the system ROM with the latest BIOS 
image using the BIOS Recovery procedure.

2. Replace the system board.

System does not power on and 
LEDs are not flashing.

None System unable to power on. Press and hold the power button for less than four 
seconds. If the hard drive LED turns white, the power 
button is working correctly. Try the following:

1. Remove the power cord from the computer.

2. Open the computer and press the yellow CMOS 
button on the system board for four seconds 
(located near the front USB ports).

3. Verify that the AC cord is plugged into the 
power supply.

4. Close the unit and reattach the power cord.

5. Try to power on the computer.

6. Replace the unit.
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POST numeric codes and text messages
This section covers those POST errors that have numeric codes associated with them. The section also 
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table B-4  Numeric Codes and Text Messages

Control panel message Description Recommended action

103-System Board Failure DMA or timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card contains an 
option ROM too large to download during POST.

1. If a PCI expansion card was recently 
added, remove it to see if the problem 
remains.

2. In Computer Setup, set Advanced > 
Device Options > NIC PXE Option ROM 
Download to DISABLE to prevent PXE 
option ROM for the internal NIC from being 
downloaded during POST to free more 
memory for an expansion card's option 
ROM. Internal PXE option ROM is used for 
booting from the NIC to a PXE server.

161-Real-Time Clock Power Loss Invalid time or date in configuration memory.

RTC (real-time clock) battery may need to 
be replaced.

Reset the date and time under Control Panel 
(Computer Setup can also be used). If the 
problem persists, replace the RTC battery. See 
the Removal and Replacement section for 
instructions on installing a new battery, or 
contact an authorized dealer or reseller for RTC 
battery replacement.

164-MemorySize Error Memory amount has changed since the last 
boot (memory added or removed).

Press the F1 key to save the memory changes.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly 
installed.

2. Verify proper memory module type.

3. Remove and replace the identified faulty 
memory module(s).

4. If the error persists after replacing 
memory modules, replace the system 
board.

214-DIMM Configuration Warning Populated DIMM Configuration is not optimized. Rearrange the DIMMs so that each channel has 
the same amount of memory.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest BIOS 
image.
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Table B-4  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

512-Chassis, Rear Chassis, or Front Chassis Fan 
not Detected

Chassis, rear chassis, or front chassis fan is not 
connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front 
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front 
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may have 
malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

912-Computer Cover Has Been Removed Since 
Last System Startup

Computer cover was removed since last system 
startup.

No action required.

921-Device in PCI Express slot failed to initialize There is an incompatibility/problem with this 
device and the system or PCI Express Link could 
not be retrained to an x1.

Try rebooting the system. If the error reoccurs, 
the device may not work with this system

1720-SMART Hard Drive Detects Imminent 
Failure

Hard drive is about to fail. (Some hard drives 
have a hard drive firmware patch that will fix an 
erroneous error message.)

1. Determine if hard drive is giving correct 
error message. Run the Drive Protection 
System test using F2 Diagnostics.

2. Apply hard drive firmware patch 
if applicable. (Available at 
http://www.hp.com/support.)

3. Back up contents and replace hard drive.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer 
Setup.

Network Server Mode Active and No Keyboard 
Attached

Keyboard failure while Network Server Mode 
enabled.

1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.
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Troubleshooting

Basic troubleshooting

If the thin client is experiencing operating problems or will not power on, review the following items.

Table B-5  Power-on troubleshooting

Issue Procedures

The thin client unit is experiencing operating 
problems.

Ensure that the following connectors are securely plugged into the thin client unit:

Power connector, keyboard, mouse, network RJ-45 connector, display

The thin client unit does not power on. 1. Verify that the power supply is good by installing it on a known working unit and 
testing it. If the power supply does not work on the test unit, replace the power 
supply.

2. If the unit does not work properly with the replaced power supply, have the unit 
serviced.

The thin client unit powers on and displays a 
splash screen, but does not connect to the 
server.

1. Verify that the network is operating and the network cable is working properly.

2. Verify that the unit is communicating with the server by having the System 
Administrator ping the unit from the server:

— If the thin client pings back, then the signal was accepted and the unit is 
working. This indicates a configuration issue.

— If the thin client does not ping back and the thin client does not connect to 
the server, re-image the unit.

No link or activity on the network RJ-45 LEDs 
or the LEDs do not illuminate blinking green 
after powering on the thin client unit. (The 
network LEDs are located inside the RJ-45 
connector on the top, rear panel of the thin 
client. Indicator lights are visible when the 
connector is installed.)

1. Verify that the network is not down.

2. Make sure the RJ-45 cable is good by installing the RJ-45 cable onto a known 
working device—if a network signal is detected then the cable is good.

3. Verify the power supply is good by replacing the power cable to the unit with a 
known working power supply cable and testing it.

4. If network LEDs still do not light and you know the power supply is good, then 
re-image the unit.

5. If network LEDs still do not light, run the IP configuration procedure.

6. If network LEDs still do not light, have the unit serviced.

A newly connected unknown USB peripheral 
does not respond or USB peripherals 
connected prior to the newly connected USB 
peripheral will not complete their device 
actions.

An unknown USB peripheral may be connected and disconnected to a running 
platform as long as you do not reboot the system. If problems occur, disconnect the 
unknown USB peripheral and reboot the platform.

Video does not display. 1. Verify that the monitor brightness is set to a readable level.

2. Verify the monitor is good by connecting it to a known working computer and 
ensure its front LED turns green (assuming the monitor is Energy Star 
compliant). If the monitor is defective, replace it with a working monitor and 
repeat testing.

3. Re-image the thin client unit and power on the monitor again.

4. Test the thin client unit on a known working monitor. If the monitor does not 
display video, replace the thin client unit.
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Diskless (No-Flash) unit troubleshooting

This section is only for those units that do not have ATA Flash capability. Because there is no ATA Flash in this 
model the boot priority sequence is:

● USB device

● PXE

1. When the unit boots, the monitor should display the following information:

Table B-6  Diskless unit troubleshooting

Item Information Action

MAC Address NIC portion of the system board is OK If no MAC Address, the system board is at fault. Contact the 
Call Center for service.

GUID General system board information If no GUID information, the system board is at fault and 
should be replaced.

Client ID Information from server If no Client ID information there is no network connection. 
This may be caused by a bad cable, the server is down, or a 
bad system board. Contact the Call Center for service for the 
bad system board.

MASK Information from server If no MASK information there is no network connection. This 
may be caused by a bad cable, the server is down, or a bad 
system board. Contact the Call Center for service for the bad 
system board.

DHCP IP Information from server If no DHCP IP information there is no network connection. 
This may be caused by a bad cable, the server is down, or a 
bad system board. Contact the Call Center for service for the 
bad system board.

If you are running in a Microsoft RIS PXE environment, go to step 2.

If you are running in a Linux environment, go to step 3.

2. If you are running in a Microsoft RIS PXE environment, press the F12 key to activate the network service 
boot as soon as the DHCP IP information appears on the screen.

If the unit does not boot to the network, the server is not configured to PXE.

If you missed the F12 cue, the system will try to boot to the ATA flash that is not present. The message 
on the screen will read: ERROR: Non-system disk or disk error. Replace and press any key when ready.

Pressing any key will restart the boot cycle.

3. If you are running in a Linux environment, an error message will appear on the screen if there is no Client 
IP. ERROR: Non-system disk or disk error. Replace and press any key when ready.
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Configuring a PXE server
NOTE: All PXE software is supported by authorized service providers on a warranty or service contract basis. 
Customers who call the HP Customer Service Center with PXE issues and questions should be referred to their 
PXE provider for assistance. 

Additionally, refer to the following:

– For Windows 2008 R2: http://technet.microsoft.com/en-us/library/7d837d88-6d8e-420c-b68f-
a5b4baeb5248.aspx

– For Windows 2012: http://technet.microsoft.com/en-us/library/jj648426.aspx

The services listed below must be running, and they may be running on different servers:

1. Domain Name Service (DNS)

2. Remote Installation Services (RIS)

NOTE: Active Directory DHCP is not required, but is recommended.
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C Using HP ThinUpdate to restore the image

HP ThinUpdate allows you to download images and add-ons from HP, capture an HP thin client image, and 
create bootable USB flash drives for image deployment.

HP ThinUpdate is preinstalled on some HP thin clients, and it is also available as an add-on at 
http://www.hp.com/support (search for the thin client model and see the Drivers & software section of the 
support page for that model).

● The Image Downloads feature lets you download an image from HP to either local storage or a USB flash 
drive. The USB flash drive option creates a bootable USB flash drive that can be used to deploy the image 
to other thin clients.

● The Image Capture feature lets you capture an image from an HP thin client and save it to a USB flash 
drive, which can be used to deploy the image to other thin clients.

● The Add-on Downloads feature lets you download add-ons from HP to either local storage or a USB flash 
drive.

● The USB Drive Management feature lets you do the following:

— Create a bootable USB flash drive from an image file on local storage

— Copy an .ibr image file from a USB flash drive to local storage

— Restore a USB flash drive layout

You can use a bootable USB flash drive created with HP ThinUpdate to deploy an HP thin client image to 
another HP thin client of the same model with the same operating system.

System requirements

To create a recovery device for the purpose of reflashing or restoring the software image on the flash, you will 
need the following:

● One or more HP thin clients.

● USB flash device in the following size or larger:

— ThinPro: 8 GB

— Windows 10 IoT (if using the USB format): 32 GB

NOTE: Optionally, you can use the tool on a Windows computer.

This restore method will not work with all USB flash devices. USB flash devices that do not show up as 
removable drive in Windows do not support this restore method. USB flash devices with multiple partitions 
generally do not support this restore method. The range of USB flash devices available on the market is 
constantly changing. Not all USB flash devices have been tested with the HP Thin Client Imaging Tool.
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D Device management

The t730 includes a license for HP Device Manager and has a Device Manager agent pre-installed. HP Device 
Manager is a thin client optimized management tool used to manage the full life cycle of HP thin clients to 
include Discover, Asset Management, Deployment and Configuration. For more information on HP Device 
Manager, please visit www.hp.com/go/hpdm.

If you wish to manage the t730 with other management tools such as Microsoft SCCM or LANDesk, go to 
www.hp.com/go/clientmanagement for more information.
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E Adding an Image Restore Tool

1. Ensure that the boot order is set to use the Network as the first boot device.

2. Ensure that IBR.exe (Image Restore) and Flash.dd are stored in the same directory on the server. (e.g., 
c:\program files\altiris\express\deployment server\images)

3. From the Altiris Deployment Server Console, click File > New > Job .

4. Enter a unique name for the job that you will use to deploy the original thin client image.

5. Click the name of the new job.

6. Near the upper right side of the screen, click Add.

7. Select Run Script from the menu.

8. Type [full path]images\ibr\exe-y\images\flash.xx hd0 

NOTE: Linux uses the file name FLASH.DD while other operating system images use FLASH.IMG

9. Under In which OS would you like to run this script? Click DOS.

10. Click Finish.

11. You can now drag and drop the job onto the appropriate machine(s) or schedule it to run later, 
depending on your needs. Refer to the documentation for Altiris Deployment Solution 
(http://www.altiris.com/support/documentation) for more detailed information.

46 Appendix E   Adding an Image Restore Tool

http://www.altiris.com/support/documentation


F Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature on 
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power 
supplies on those computers that do not have external power switches are equipped with internal switches 
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you 
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the 
computer.

General requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the 
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage 
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be 
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or 
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits 
from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in 
any manner, replace it immediately.

Japanese power cord requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.

General requirements 47



Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance coupler and 
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must be a two-pole 
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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G Statement of Volatility

Thin Client products typically have three types of memory devices namely, RAM, ROM, and Flash memory 
devices. Data stored in the RAM memory device will be lost once the power is removed from the device. RAM 
devices could be powered by main, aux, or battery power (power states are explained below). Therefore, even 
when the unit is not connected to an AC outlet, some of the RAM devices could be powered by battery power. 
Data stored in the ROM or Flash memory devices will retain its data even if the power is removed to the 
device. Manufacturers of Flash device usually specify a period of time (in the order of ten years) for data 
retention.

Definition of power states:

Main Power: Power available when the unit is turned on.

Aux or Standby power: Power available when the unit is in off state when the power supply is connected to 
an active AC outlet.

Battery Power: Power from a coin battery present in the Thin Client systems.

The table below lists the available memory devices and their types per the models. Please note that the Thin 
Client systems do not use traditional hard drives with moving parts. Instead, they use flash memory devices 
with an IDE/ SATA front-end interface. Hence, the operating systems interface with these flash devices similar 
to a regular IDE/ SATA hard drive. This IDE/ SATA flash device contains the image of the operating system. The 
flash device can only be written by an administrator. A special software tool is required to format the flash 
devices and clear the data stored in them.

Please find below a list of steps that should be taken to update BIOS and use it to set the BIOS settings to 
factory default settings.

1. Download the latest BIOS for your model off of the HP website.

Download the latest BIOS (system ROM) from the HP website.

Download the latest BIOS for your model off of the HP website.

2. Follow the instructions to flash the BIOS that are found on the website.

Follow the instructions to flash the BIOS that are found on the website.

Follow the instructions to flash the BIOS that are found on the website.

3. Restart the system, and while system is powering on (after the HP splash screen, if displayed) press the 
F10 key to enter the BIOS setup screen.

Turn on the system, and while system is powering on, and after the HP splash screen, press the F10 key 
to enter BIOS setup screen.

Restart the system, and while system is powering on (after the HP splash screen, if displayed) press the 
F10 key to enter the BIOS setup screen.

4. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System IDs.

Set defaults and exit (this will clear passwords and any other settings)

If the Ownership Tag or Asset Tag is set, manually clear it under Security > System IDs.

5. Select File > Save Changes and Exit.
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6. To clear the Setup or Power-On passwords if set, and clear any other settings, power down the computer 
and remove the AC power cord and the computer hood.

7. Locate the (blue/green) two pin password jumper on header E49 (labeled PSWD) and remove it.

8. Remove AC power, wait ten seconds until the unit AC power has drained out, then press the clear CMOS 
button. (This is usually a yellow push button, labeled CMOS).

9. Replace the hood and AC power cord and turn the computer on. The passwords are now cleared and all 
other user-configurable, non-volatile memory settings are reset to their factory default values.

10. Re-enter the F10 setup utility.

11. Select File > Default Setup > Restore Factory Settings as Default. This will set the default settings 
back to the factory defaults.

12. Select File > Apply Defaults and Exit.

13. Shut down the computer, remove AC power cord, and then place the (blue/green) jumper back on header 
E49. Replace the computer hood and power cord.

Model Description Location/Size Power Loss of data Comments

t730

System Boot ROM 
(BIOS)

SPI ROM (64 Mbit) 
socketed, 
removable.

   

System memory 
(RAM)

SODIMM socket. 
Removable (4GB/
8GB)

Main power If main power is 
removed

Only S0/S3/S5/G3 
ACPI states are 
supported

RTC (CMOS) RAM RTC RAM is 272–
byte RAM Memory 
embedded in AMD 
APU’s Fusion 
Controller Hub 
(FCH).

Main/battery If battery power is 
removed

 

Keyboard/mouse 
(ROM)

2k bytes embedded 
in the super I/O 
controller (SIO12)

Main   

Keyboard/mouse 
(RAM)

256 bytes 
embedded in the 
super I/O controller 
(SIO12)

Main If main power is 
removed

 

LOM EEPROM 256 bytes 
embedded in LAN 
Chip

Aux  One Time 
programmable 
memory (OTP)

TPM 6 kBytes embedded 
in TPM Chip. It’s 
ROM for TCG 
Firmware

Main   

The information contained herein is subject to change without notice.

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

If you require additional information or need assistance please contact James Smalls at 281-514-5723.
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H Specifications

For the latest specifications or additional specifications on the thin client, go to http://www.hp.com/go/ 
quickspecs/ and search for your specific thin client to find the QuickSpecs.

Item Value Value

Dimensions

Width

Depth

Height (without stand)

Height (with stand)

65 mm

220 mm

240 mm

250 mm

2.56 in.

8.66 in

9.45 In

9.84 in.

Temperature Range (fanless design)*

Operating**

Nonoperating

(max. rate of change is 20°C per hour or 36°F per hour)

10°C to 40°C

-30°C to 60°C

50°F to 104°F

-22°F to 140°F

*Specifications are at sea level with altitude derating of 
1°C/300 m (1.8°F/1000 ft) to a maximum of 3 Km (10,000 ft), 
with no direct, sustained sunlight. Upper limit may be limited 
by the type and number of options installed.

** The operating temperature range when the thin client is 
attached to a flat panel using the HP Quick Release is 10°C 
to 35°C (50°F to 95°F).

Relative Humidity (non-condensing)

Operating

(max. wet bulb temperature is 28°C or 84.2°F)

Nonoperating

(max. wet bulb temperature is 38.7°C or 101.6°F)

10% to 90%

5% to 95%

Maximum Altitude (unpressurized)

Operating

(max. allowed rate of change is 457 m per minute or 1500 ft 
per minute)

Nonoperating

(max. allowed rate of change is 457 m per minute or 1500 ft 
per minute)

3048 m

9144 m

10,000 ft

30,000 ft

Power Supply

Operating Voltage Range

Rated Line Frequency

 
100 VAC to 240 VAC

50 Hz to 60 Hz

Power Output (maximum)  85 W

Rated Output Current (maximum)  4.36 A

Output Voltage  +19.5 V dc
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